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This file lists all changes made to SAP2000 since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant and are included in the 

ReadMe file. 

Changes from v16.0.2 (Released 2013-11-06) 

Modeling 
Enhancements Implemented 

* Incident Description 

* 27098 The specification of the notional size used for time-dependent creep and shrinkage analysis has been 

enhanced to now be specified with the frame and shell section properties instead of with the 

material property. This now provides three options:  (1) "Auto", in which the notional size will be 

calculated automatically based on the section dimensions, when applicable.  (2) "User", in which the 

user specifies an explicit value to be used for the section.  (3) "None", in which creep and shrinkage 

is ignored. Models from older versions that used the notional size in the material property will be 

updated so that each frame or shell section uses the previously specified value from the material as a 

"User" value in the section definition. Models from older versions that used material overwrites may 

produce different creep or shrinkage results if the notional size in the material overwrite assigned to 

a frame or shell object is different from that in the material used by the section assigned to that same 

object. Identical results can be obtained by manually adding new sections with the notional size 

value equal to that in the material overwrites, and assigning them to the affected objects. 

* 34973 A bilinear Maxwell viscous damper has been implemented as a new link property. This device is a 

linear spring in series with a dashpot whose force-velocity relationship exhibits linear viscous 

behavior up to a specified force-velocity limit. When the force and velocity exceeds this limit, the 

additional damping force is proportional to the additional velocity by a different, smaller damping 

coefficient. The behavior is symmetrical with the sign of the velocity. 

* 60259 A friction-spring hysteretic damper has been implemented as a new link property. The force-

displacement relationship exhibits linear slipping stiffness when loading, but unloads with a smaller 

slipping stiffness. A pre-compression displacement and a displacement stop-limit may be specified. 

The behavior may be specified as tension-only, compression-only, or symmetrical in tension and 

compression. 
* 60261 A new staged-construction operation “Change Section & Age” is now available allowing 

specification of the “Age at Add” when changing frame sections or shell sections. This age affects 

time-dependent analysis for creep, shrinkage, and stiffness. The existing operation “Change 

Section” uses the age of the member as it was before the section was changed. In either case, the 

member is removed and re-added in the same location without retaining any of the strain or load 

history, as before. 

 61085 The section property database files Chinese.pro and ChineseGB08.pro have been enhanced by 

adding new sections. In addition, the section GB-I12.6 in ChineseGB08.pro was updated for an 

incorrect value of I33. 

 61537 An enhancement was implemented where rotation of joint local axes when doing radial replication 

works for replication around lines in the global X, Y and Z directions.  Previously, it only worked 

for replication about a line in the global Z direction. 
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Graphics 
Enhancements Implemented 

* Incident Description 

 33625 The graphical user interface has been enhanced so that the keyboard arrow keys (left, right, up, 

down) can be used to rotate 3D views of the model, similar to the use of the middle-mouse button 

with the Shift key and the command Rotate 3D View. 

Loading 
Enhancements Implemented 

* Incident Description 

* 56833 An enhancement has been implemented adding auto-lateral wind loading according to the API 4F 

2013 code. 

 

Results Display and Output 
Enhancements Implemented 

* Incident Description 

* 17908 Table output may now optionally include the correspondence between the response components at a 

single location for additive-, range-, and enveloping-type load combinations when correspondence 

is available for the contributing load cases and combinations. Response that admits correspondence 

includes joint displacements and reactions; frame forces at a given station; stresses at a given joint 

for shells, planes, asolids, and solids; forces and deformations in links; element-joint forces, section 

cuts; and base reactions. Correspondence is available for single and multi-step load cases, moving-

load cases when correspondence is specified for analysis, and combinations of such cases. 

Correspondence is not available for response-spectrum, steady-state, and PSD load cases. 

Correspondence is not available for moving-load cases for element joint forces and base reactions. 

Correspondence requested for table output (Display > Show Tables and File > Export of tables) 

does not affect any other type of display, design, or the Open API functions. 

Frame Design 
Enhancements Implemented 

* Incident Description 

* 58212 The API RP 2A-WSD 21st edition steel frame design has been updated for supplements 1, 2, and 3. 

This only affects the joint punching checks which differ in supplements 2 and 3 from the original 

implementation. A new option in the steel design preferences allows the desired supplements to be 

selected. 

* 60228 Steel frame design has been added according to the Norsok N-004 2013 code. 
 61328 An enhancement has been made to allow the Robertson constant to be overwritten for steel frame 

design according to the BS 5950-1:2000 code. 

External Import/Export 
Enhancements Implemented 

* Incident Description 

 58602 An incident was resolved that addresses several issues with the import of STAAD files: (1) When a 

STAAD load case includes a self-weight specification in the vertical direction for the entire 

structure, this is imported in SAP2000 as a selfweight multiplier for the generated load pattern. 

Previously, SAP2000 self-weight loads were being generated for all frame objects, and no loads 

were generated for area objects. (2) When a STAAD load case includes a self-weight specification 

for a specific set of STAAD members or elements, SAP2000 self-weight loads are now generated 

only for the corresponding SAP2000 frame or area objects. Previously, no SAP2000 loads were 

being generated for the area objects and SAP2000 loads were being generated for all frame objects, 

possibly resulting in multiple self-weight loads on individual SAP2000 frame objects. When this 

occurred, the results agreed with the model as imported. (3) When the STAAD joint numbering was 
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* Incident Description 

not sequential, the SAP2000 joint constraints created for the STAAD Master Slave commands 

occasionally referred to incorrect SAP2000 joints. They now refer to the correct joint numbers. 

When this occurred, the results agreed with the model as imported. (4) When a STAAD model 

included reference loads, load combinations were usually not being imported. Models without 

reference loads were not affected. This error did not affect versions prior to v16.0.0, since reference 

loads were not supported in the prior versions. (5) The names of the generated SAP2000 load 

patterns, load cases, and load combinations are now compound names starting with the number of 

the original STAAD load case or load combination, followed by its title. Previously, load cases and 

combinations were compound names starting with the prefix PattSTD or ComboSTD, as applicable, 

followed by the number of the original STAAD load case or load combination. (6) STAAD 

response-spectrum functions and load cases are now imported. 
* 59254 Import of SACS input files is now available, currently handling geometry, steel section properties, 

materials, and basic loading. This feature will be enhanced over time to import additional data from 

the SACS input file. 

Documentation 
Enhancements Implemented 

* Incident Description 

 51012 A new design manual is provided which documents the API RP 2A-WSD 21st edition frame design 

and joint punching checks. This includes the supplements to the 21st edition, which have also been 

implemented in v16.1.0 under Incident 58212. 

 

 

 

Modeling 
Incidents Resolved 

* Incident Description 

 27807 An incident was resolved where assigned “Frame Joint Offsets to Cardinal Point” were not retained 

when a frame object was divided. The cardinal point itself was retained, but not any additional joint 

offsets. This error only affected frame objects that are divided using the command Edit > Edit Lines 

> Divide Frames, but not frame objects that were automatically meshed for analysis using the 

command Assign > Frame > Automatic Frame Mesh. Results agreed with the model as it existed 

after the divide operation was performed. 

User Interface and Display 
Incidents Resolved 

* Incident Description 

 60718 An incident was resolved where changing a quake-type load pattern from User Loads to IBC 2009 

in the form would revert back to user loads when the form was closed. 

 61123 An incident was resolved in which setting Windows shortcut properties to run SAP2000 maximized 

would generate an exception (runtime error) when the software was started. Continuing through the 

exception would allow the software to run as normal. Now the exception is no longer generated. 

Graphics and Drafting 
Incidents Resolved 

* Incident Description 

 58060 An incident was resolved where the onscreen rotation of the model would not correctly update the 

drawing resulting in views where hidden lines could be seen. 

 58125 An incident was resolved in which the display of wave loading applied to frames did not show the 

wave profile behind the model. This was a graphical display issue only and did not affect results. 
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* Incident Description 

 58759 An incident was resolved where the command Draw > Quick Draw Frame/Cable/Tendon, when 

used for Frames, always set the moment releases as continuous even when the pinned option was 

selected if the option was translated into a language other than English. 

 58894 

61197 

61291 

An incident was resolved in which the objects to be displayed in a window was reset to 'Show All' 

after previously using the 'Show Selection Only' option and then using the 'Show Undeformed 

Shape' command. This was a graphics issue only and did not affect results. 

 59612 An incident was resolved where certain section designer sections with multiple section objects 

could not be shown extruded correctly when displaying deformed shape. This was a graphical issue 

only and did not affect results. 
 60393 An incident was resolved in which the extruded view of a nonprismatic member composed of 

section designer shapes was not correct after dividing the nonprismatic frame into multiple smaller 

segments. This was a graphical issue only and did not affect results. 

 60935 An incident was resolved in which the View > Show All command didn't always work after 

previously using the View > Show Selection Only command. 

Loading 
Incidents Resolved 

* Incident Description 

* 58865 An incident has been resolved where the sign of the vertical acceleration was incorrect for wave 

loadings using Stokes 5th order wave theory. This affected the vertical load component computed 

from acceleration. The vertical load component computed from velocity and the computed 

horizontal loads were not affected by this error. 

 60253 An incident was resolved where wind loads applied through area objects were not being calculated 

if the area object had more than 4 nodes. 

Analysis 
Incidents Resolved 

* Incident Description 

* 58274 An incident was resolved where the direct stresses (S11, S22, and S33) reported in plane-strain and 

Asolid elements are incorrect under temperature loading. The error was approximately equal to the 

Poisson's ratio of the material times the restrained thermal stress S33. Solid, Shell, and Plane-stress 

elements were not affected. 

 60964 An incident was resolved where the analysis could be terminated prematurely and the analysis 

results lost if previous analysis results were present and were being displayed in the graphical user 

interface (GUI) before an analysis was started and then the GUI was minimized and maximized or 

otherwise resized while the analysis was running. Only models running the analysis as a separate 

process (either set explicitly by the user or determined automatically by the program) were affected. 

When this occurred, the model would be unlocked so that it was obvious that the results were lost. 

In some cases an error message was generated. Analysis results, if not lost, were correct and not 

affected by this error. 

 
Results Display and Output 
Incidents Resolved 

* Incident Description 

 60112 An incident was resolved where an error message was generated when plotting frame forces or 

stresses if a general frame section property had been defined for which the value of the cross 

moment of inertia, I23, was specified such that I22*I33 - I23*I23 was equal to zero. No results that 

were able to be displayed or output were affected. 
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Database Tables 
Incidents Resolved 

* Incident Description 

 61364 An incident was resolved for a rare issue where cable strain loads modified using the Interactive 

Database Editor would add the previous load rather than replace the previous load. The problem 

only occurred in models that had no frame objects. 

 
Frame Design 
Incidents Resolved 

* Incident Description 

 33430 An incident was resolved for concrete frame design where the "Consider Minimum Eccentricity" 

option in the Design Preferences for certain codes was not being used. The minimum eccentricity 

was always being enforced regardless of the option chosen, and the resulting design results were 

conservative. The affected codes are ACI 318-02, ACI 318-05, ACI 318-08, ACI 318-11, AS 3600-

2001, and AS 3600-2009.  For BS8110 89 and EUROCODE 2-1992 codes, the only affected frames 

are Sway Frames as the parameter was already being used for non-sway frames. 
 49301 An incident was resolved for steel frame design where, in some rare cases, a span could be 

classified as a cantilever (based on loading) when it was not and its deflection was thus incorrectly 

calculated for deflection checks. 
 59787 An incident has been resolved for concrete frame design according to the ACI 318-11 code in which 

the design always showed an error message indicating shear failure whenever shear rebar was 

needed, i.e. when the shear stress was more than the minimum of 0.5*phi*vc, even if the shear 

design was adequate. The error only affected versions 16.0.0 to 16.0.2. 
 60246 An incident was resolved for steel frame design using the Eurocode 3-2005 code in which the C1 

factor was sometimes greater than the code specified limit of 2.7. 

 61390 An incident was resolved where the frame design was taking much longer in SAP2000 v16 

compared to SAP2000 v14. This was due to inadvertent additional calculations being performed 

that were not needed for frame design. No results were affected. 
 62200 An incident was resolved for the API RP 2A punching checks in which two items were identified.  

(1) If the Qf factor was negative the punching check was still carried out. Now an error is issued 

indicating that the chord is overstressed and can't carry the punching shear.  (2) When permitted, the 

1/3 increase was not being applied in the nominal load method calculation of Pa and Ma. 

 
Data Files 
Incidents Resolved 

* Incident Description 

* 60086 An incident has been resolved where model files from v15.2.0 or v15.2.1 containing frame sections 

imported from databases may have inadvertently contained nonzero values of shear center when 

they should have been zero. Versions 15.2.0 to v16.0.2 account for the shear center location and 

therefore the results were affected by this error. Versions after v16.0.2 will check for non-zero 

values and set them to zero for sections that should not have non-zero values. 

 
External Import/Export 
Incidents Resolved 

* Incident Description 

* 59285 An incident was resolved where the contribution of braces to exported reactions from SAP2000 to 

SAFE was missing. The contributions of columns, walls, and ramps were not affected by this error. 
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Open Application Programming Interface 
Incidents Resolved 

* Incident Description 

 57867 An incident was resolved for the OAPI in which the functions 

SapObject.SapModel.LoadPatterns.AutoWind.SetASCE702, SetASCE705, and SetASCE710 were 

not accepting values greater than 2 for the ExposureFrom parameter. 

 58954 An incident was resolved in the OAPI in which the function 

SapModel.PropFrame.SDShape.GetReinfEdge would return an error when there was no 

reinforcement on some edges of a Section Designer section object. 

 59407 An incident was resolved in the Open API that corrects two problems when creating Section 

Designer sections:  (1) The function SapModel.PropFrame.SDShape.SetSolidRect and the similar 

Set functions for all other shapes were not setting the front/back order for added shapes, such that 

visibility of the shapes may not be as expected. Section properties were calculated for the shapes 

with the front/back order as shown.  (2) The number of points was not being correctly set for 

rectangular reinforcement objects within a Section Designer section using the functions 

SapModel.PropFrame.SDShape.SetReinfRectangular and 

SapModel.PropFrame.SDShape.SetSolidRect, which was causing an error in number and placement 

of the rebar. 
 60667 An incident was resolved for the Open API in which it was not possible to set all the insertion-point 

offsets back to zero using the function SapModel.FrameObj.SetInsertionPoint if any of them had 

been set to non-zero values. 

 
Documentation 
Incidents Resolved 

* Incident Description 

 56349 A documentation error has been corrected in the Technical Note named S-TN-RCS-001.pdf related 

to the reinforcement design for concrete shells. The lever arm for equivalent in-plane shear in the 

top and bottom layers was incorrectly mentioned as dbmax and dtmax respectively. This has been 

corrected to be dbmin and dtmin throughout the documentation, where applicable. No results are 

affected. 

 61966 An incident was resolved in which the documentation for Norsok N-004 2004 was updated for the 

following minor items:  (1) Frame design indicated equations for calculating W and Z, when the 

software actually uses the values from the frame section definition.  (2) The punching-check 

equation 6.53 was documented with '0.8d' when it should have been 'd'.  (3) The punching-check 

equation 6.55 was documented as 'A' when it should have been 'A^2'.  (4) The punching-check 

equation for Qg when g/T >= 2.0 was documented with a '1' when it should have been '1.9'.  (5) For 

punching checks the limits on beta, gamma, and theta have been documented. Item (1) is in the 

"Norsok N-004-2004 Steel Frame Design Manual". The other four items are in the "Norsok N-004-

2004 Punching Load Check" Technical Note. No results were affected by any of these items. 

 
Installation and Licensing 
Incidents Resolved 

* Incident Description 

 58722 An incident was resolved in which Windows configured the program the first time it was run after 

installation. After completing the configuration the program would run as normal. This was 

previously corrected in v16.0.2, but inadvertently omitted from the release notes. 

 

Miscellaneous 

* Incident Description 

 60108 The version number has been changed to v16.1.0 for a new minor release. 

 


